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Introduction
You can broadcast your audio and video content to network
without any additional costs by using the ForwardT Software
set and a stream broadcasting application (Windows Media
Encoder or Adobe Flash Media Encoder).
Note:

This User’s Guide is valid for newer versions of the programs of
similar functionality as well.

Windows Media Encoder (WME) is intended to encode audio
and video content and to distribute it to network in Windows
Media formats. In addition, the encoder can store the audio and
video content to a file of the appropriate format that allows it to
be used for archiving the translation.
Note:

Windows Media format is useful for archiving as such files are rather
small and can be played back in any computer with Windows Media
Player.

The Adobe Flash Media Encoder (FME) is intended to encode
audio and video content and to distribute it to network in Flash
Video format.
In the solution we propose to capture video and audio from
input/output of a board (FD300/FD322/FD422) to WME/FME
stream DirectShow filters from the ForwardT Software set are
used.
This document provides information about:
●● possible stream broadcast schemes using the
ForwardT Software set and a stream broadcasting
application (Windows Media Encoder or Adobe Flash
Media Encoder);
●● how to customize encoders for stream broadcasting;
●● how to customize WME for archiving of the content
being broadcasted.

gg

Tip: The current Windows Media Encoder and Adobe Flash Media
Encoder are available through the following links:
●● Windows Media Encoder;
●● Adobe Flash Media Encoder.

4

Stream broadcasting schemes and
general workflows for their realization
Here are two possible stream broadcasting schemes:
●● Retranslation: signal reception and stream
broadcasting to network without alterations or
additions;
●● Translation according to the schedule: signal reception
and stream broadcasting (to television and/or
computer network) according to the schedule you want
to playback using the FDOnAir application.

1. Broadcasting without alterations
When broadcast is organized according to this scheme, the
content may be received from an analog or SDI source and
distribute to computer network without any alterations in the
broadcast schedule.
The figure below presents this scheme.

1. To capture the signal the FD300/FD322/FD422 board (1) is
used.
Note:

Both input lines of the board can be used simultaneously. Lines are
designed as follows: Line A and Line B for FD300; Input 1 and Input 2
for FD322/FD422.

2. DirectShow filters from the ForwardT Software set (2)
capture audio and video from board input to stream.
3. Media Encoder (WME/FME) processes the stream and
transmits it to network (3). It is also possible to store
the content to a file on the hard disk during the stream
broadcasting.
To configure broadcast according to this scheme follow the steps
below (for detailed information on each step see the appropriate
subsections of this User’s Guide; for more information on
encoders, see their help files):
1. Connect sources of the signal to the board being used.
2. Configure the board parameters using the appropriate
application:
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FDConfiguration for FD300 (see the FDConfiguration
– FD300 board settings User’s Guide);
●● FDConfig2 for FD322/FD422 (see the FDConfig2
FDExt boards settings User’s Guide).
●●

3. If you use FD300, enable DirectShow filters from the
ForwardT Software set using the FDConfiguration
application.
If you use FD322/422, DirectShow filters are enabled
automatically when you finish board configuring in
FDConfig2.
4. Set broadcast parameters in WME/FME.
Specify a source: DirectShow filter capturing audio/video
from the input line being used.
5. Launch broadcast in WME/FME.

2. Translation according to the schedule
Using this scheme, you can broadcast according to your
own schedule. You can insert content from hard disk to the
signal (analog or SDI) received from external source, titling,
etc. It is possible to broadcast either to computer network
(local or Internet) only or to computer and television network
simultaneously.
The figure below presents this scheme.

1. To manage the broadcast (scheduling, translation and
broadcasting control) the FDOnAir application is used (1).
2. To capture, process and transmit audio and video to
television network (3) the FD300/FD322/FD422 board is
used (2).
3. DirectShow filters from the ForwardT Software set (2)
capture audio and video from board output to stream.
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4. Media Encoder (WME/FME) processes the stream and
transmits it to network (5). It is also possible to store
the content to a file on the hard disk during the stream
broadcasting.
To configure broadcast according to this scheme follow the steps
below (for detailed information on each step see the appropriate
subsections of this User’s Guide; for more information on
encoders, see their help files):
1. Connect sources of the signal to the board being used.
2. Configure the board parameters using the appropriate
application:
●● FDConfiguration for FD300 (see the FDConfiguration
– FD300 board settings User’s Guide);
●● FDConfig2 for FD322/FD422 (see the FDConfig2
FDExt boards settings User’s Guide).
3. If you use FD300, enable DirectShow filters from the
ForwardT Software set using the FDConfiguration
application.
If you use FD322/422, DirectShow filters are enabled
automatically when you finish board configuring in
FDConfig2.
4. Launch and configure the FDOnAir application and
create a broadcast schedule (see the FDOnAir – Broadcast
Automation and FDOnAir – Additional Sections User’s
Guides).
5. Set broadcast parameters in WME/FME.
Specify a source: DirectShow filter capturing audio/video
from the output line being used.
6. Start your schedule in the FDOnAir application.
7. Launch stream broadcast to network in WME/FME.
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DirectShow filters (for the FD300 board)
This information is valid for the ForwardT Software 5.0.2
version and above for the FD300 board.

1. To enable DirectShow filters
88 Important: Enable DirectShow filters before configuring stream broadcast
in WME/FME. If any broadcasting program is opened
(FDOnAir, WME/FME), close it.

1. Launch the FDConfiguration application using its shortcut
on the desktop or by clicking Start: Programs > ForwardT Software > Board Setup > FD300 Configuration.
2. Select in the Boards’ Indexes list (1) the board that is used for
audio and video capture and click Advanced… (2).

1

2
5

3. In the opened window select the A/V Capture filter check box.
in the Use Direct Show filters group (3).

4

3
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4. Click OK (4) to save the settings and to close the window.
5. In the main window click OK (5) to save the settings and
exit FDConfiguration.

2. Names of filters
Table 1.

List of filters for FD300
Source

Device designation
(N – board number, in most cases N=1)

Board

Line

FD300

video input, Line A

SLTM DShow Video Capture boardN

video input, Line B

SLTM DShow Video Line B Capture boardN

video output

SLTM DShow Video Output Capture boardN

audio input, line #1

FD300 Input 1 BN

audio input, line #2

FD300 Input 2 BN

audio input, line #3

FD300 Input 3 BN

audio output, line #1

FD300 Output 1 BN

audio output, line #2

FD300 Output 2 BN

audio output, line #3

FD300 Output 3 BN
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DirectShow filters (for the FD322/FD422 board)
This information is valid for the ForwardT Software 5.3.5xx
beta version and above for the FD322/422 board.
If you use FD322/422, DirectShow filters are enabled
automatically when you finish board configuring in FDConfig2
(mode selection and device enabling). What filters are available
depends on the current configuration.

88 Important: Enable DirectShow filters before configuring stream broadcast
in WME/FME. If any broadcasting program is opened
(FDOnAir, WME/FME), close it.

1. FD322/FD422 Configuration Setting
For more detailed information on FD322/FD422 Configuration
Setting see the FDConfig2: FDExt boards settings User’s
Guide. This section presents steps on which list of available
DirectShow filters depends.
1. Launch the FDConfig2 application using its shortcut on the
desktop or by clicking Start: Programs > ForwardT Software >
Board Setup > FDConfig2.
2. In the list (1) select the board being used for signal capture
and translation.

1
2

3
4

3. Make sure that in the Mode list (2) the required mode is
selected.
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88 Important: When selecting mode, make sure that you have all necessary
licenses.

4. Make sure that all required check boxes are selected in the
Device enabling group (3). To capture audio/video to WME/
FME stream from Input 1 select the Capture input #1 check
box; to capture from Input 2 select the Capture input #2 check
box. Capture from the board output is always enabled.
Note:

Depending on board type and selected mode check boxes names can be
slightly different.

88 Important: When selecting the check boxes, be sure that all required

licenses are available (for information on licenses for the
product you bought, see its description).
For example, the product may include only one license for
capturing from the board input. Thus, at one moment you
can use either Capture Input #1 or Capture input #2 but not
simultaneously.
If you have only one license and both check boxes of the Device
enabling group are selected, only Capture Input #1 is enabled. If
you need to capture audio/video from Input #2, deselect the Capture Input #1 check box and select Capture Input #2.

Note:

Information on licenses is kept in registration key and recorded into
Windows Registry when the key is activated. If there are several
boards in the system all corresponding licenses for products are taken
into account.

5. To save the settings and close the FDConfig2 program
window click OK (4).
After applying the settings, the list of available DirectShow
filters is formed. If the Capture Input #1/ Capture input #2 check box
are selected, names of the appropriate DirectShow filters are
displayed in WME/FME in the list of sources.

2. Names of filters
Names of DirectShow filters for the FDExt boards look like this:
Board_name Line_name Capture
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where:

denotes the system name of the board
being used. E.g. FD322 Board 1, FD422 Board 2. The
name indicates the board type and its number;
●● Line_name denotes the board line from which audio/
video is captured. E.g. Input 1 Video is an input video
line #1; Output Video is an output video line; Input Stereo 1 is an input stereo audio channel #1. Line name
can include also the following indications:
●● Input/ Output denotes a line type: input or output;
●● index 1 or 2 denotes the number of the line
(optional);
●● HD denotes high definition mode (optional);
●● Video/ Stereo 1/ Stereo 2 denotes type of the content:
video or audio and stereo channel index (only for
audio).
●● Capture denotes the type of filter.
●● Board_name

Table 2.

List of filters for FDExt boards
Source

Board

FD322

Line

Input 1 video line

FD322 Board N Input 1 Video Capture

Input 2 video line

FD322 Board N Input 2 Video Capture

video output

FD322 Board N Output Video Capture

Output 1 video line

FD322 Board N Output 1 Video Capture

Output 2 video line

FD322 Board N Output 2 Video Capture

audio input, Stereo channel 1LR

FD322 Board N Input Stereo 1 Capture

audio input, Stereo channel 2LR

FD322 Board N Input Stereo 2 Capture

audio output, Stereo channel 1LR

FD322 Board N Output Stereo 1 Capture

audio output, Stereo channel 2LR

FD322 Board N Output Stereo 2 Capture

Input 1 video line

FD422 Board N Input 1 Video Capture

Input 2 video line

FD422 Board N Input 2 Video Capture

Input 1 video line
for HD-SDI mode

FD422 Board N Input HD Video Capture

video output

FD422 Board N Output Video Capture

video output for HD-SDI mode

FD422 Board N Output HD Video Capture

Output 1 video line

FD422 Board N Output 1 Video Capture

(for one channel mode)

(for two separate channels mode)
(for two separate channels mode)

FD422



Device designation
(N – board number, in most cases N=1)

(for one channel mode)

(for two separate channels mode)
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Source
Board

Line

Device designation
(N – board number, in most cases N=1)

Output 2 video line

FD422 Board N Output 2 Video Capture

stereo channel #1 from SDI signal
from Input 1 line

FD422 Board N Input 1 Stereo 1 Capture

stereo channel #2, Input 1

FD422 Board N Input 1 Stereo 2 Capture

stereo channel #1, Input 2

FD422 Board N Input 2 Stereo 1 Capture

stereo channel #2, Input 2

FD422 Board N Input 2 Stereo 2 Capture

stereo channel #1, Output

FD422 Board N Output Stereo 1 Capture

stereo channel #2, Output

FD422 Board N Output Stereo 2 Capture

stereo channel #1, Output 1
(for two separate channels mode)

FD422 Board N Output 1 Stereo 1 Capture

stereo channel #2, Output 1

FD422 Board N Output 1 Stereo 2 Capture

stereo channel #1, Output 2

FD422 Board N Output 2 Stereo 1 Capture

stereo channel #2, Output 2

FD422 Board N Output 2 Stereo 2 Capture

FDVrt

video output

FDVrt Device N Output Video Capture

(virtual
board)

stereo channel #1, output

FDVrt Device N Output Stereo 1 Capture

stereo channel #2, output

FDVrt Device N Output Stereo 2 Capture

stereo channel #3, output

FDVrt Device N Output Stereo 3 Capture

(for two separate channels mode)

(for one channel mode)
(for one channel mode)
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Launching and configuring FDOnAir
The FDOnAir application is used when broadcasting according
to your own schedule.
For more information on working with the application, see the
FDOnAir – Broadcast Automation and FDOnAir – Additional
Sections User’s Guides.
1. Launch the FDOnAir application using its shortcut on the
desktop or by clicking Start: Programs > ForwardT Software >
OnAir.
2. Click Settings (1).

1

3. In the opened window select the Configuration tab (2).
4. In the drop-down lists of the Video device group select the
following:
●● device type (3):
●● FD300 for the FD300 board;
●● FDExt for the FD322/FD422 board;
●● name of the line/board being used for broadcasting (4).
The name looks like this:
●● BoardN for the FD300 board;
●● FD322 Board N Output K for the FD322 board;
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●● FD422 Board N Output K for the FD422 board;
Where N denotes the board number and K denotes the
line number (optional).

2

4

3
5

6
7

5. If you use the FD300 board, in the Audio output drop-down
list (5) select audio line on the FD300 board being used as
sound output.
6. Click Apply changes (6) to validate the adjusted settings.
Click Close (7) to exit the settings window.
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Workflow in WME
This section provides information about how you can use WME
(Windows Media Encoder) for broadcasting to network using
the ForwardT Software set.

gg

Tip: For more information on WME, see its user's guide.

1. General workflow for broadcast setting and control
1. Launch WME using its shortcut on the desktop or by
clicking Start: Programs > Windows Media > Windows Media Encoder.
2. If the New session dialog box appears, deselect Show this dialog
box at startup (1) and click Cancel (2).

1
2
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3. Open the Options window using Tools > Options... (3).

3

4. Select the required TV standard on the General tab in the
Default video format group (4).

4
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5. To customize the session open the Session Properties panel:
click Properties (5) on the toolbar (or click View > Properties
Panel).
For the 6-9 steps use the Session Properties panel.
5

7

8

6

6. Specify sources of your audio and video content on the
Sources tab:
●● See Specifying and configuring sources of your audio
and video content for retranslation;
●● See Specifing and configure sources of your audio
and video content for translation according to the
schedule.
7. Set content distribution parameters on the Output tab (see
the relevant section below).
8. Set the encoding parameters for your content on the Compression tab (see the relevant section below).
9. Click Apply (6) to validate the settings adjusted during
steps 6-8.
10. To start the broadcast click Start Encoding (7).
11. To stop the broadcast click Stop (8).
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2. Specifying and configuring sources of your audio and video content for
retranslation
1. You can specify and configure sources of your audio and
video content on the Sources tab (1) on the Session properties
panel.
2. Select the Devices radio button on the Source from radio
button group (2).
1

2

3

5
4

3. Select the Video check box (3) and in the drop-down list on
the right (4) select the DirectShow filter capturing video
from the input line of the board being used. E.g.:
●● SLTM DShow Video Capture board1 for Line A of the
FD300 board #1;
●● SLTM DShow Video Line B Capture board1 for Line B of the
FD300 board #1;
●● FD322 Board 1 Input 2 Video Capture for the Input 2 video
line of the FD322 board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters above.
4. Click Configure… (5) to open the device properties window.
Make sure that required values of the parameters are
selected.
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5. Select the Audio check box (6) and in the drop-down list on
the right (7) select the DirectShow filter capturing audio
from the input line of the board being used. E.g.:
●● FD300 Input 1 B1 for audio input #1 of the FD300
board #1;
●● FD322 Board 1 Input Stereo 1 Capture for the 1L and 1R
audio input lines (the 1st stereo channel) of the FD322
board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters above.

6

7

8

6. Click Apply (8) to validate the settings.
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3. Specifying and configuring sources of your audio and video content for
translation according to the schedule
1. You can specify and configure sources of your audio and
video content on the Sources tab (1) on the Session properties
panel.
2. Select the Devices radio button on the Source from radio
button group (2).
1

2

3
4

5

3. Select the Video check box (3) and on the drop-down list (4)
select the DirectShow filter capturing video from the output
line of the board being used (chosen for broadcasting in
FDOnAir, see point 4 of the Launching and configuring
FDOnAir section). E.g.:
●● SLTM DShow Video Output Capture board1 for output of
the FD300 board #1;
●● FD322 Board 1 Output Video Capture for the output of the
FD322 board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters above.
4. Click Configure… (5) to open the device properties window.
Make sure that required values of the parameters are
selected.
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5. Select the Audio check box (6) and in the drop-down list (7)
select the DirectShow filter capturing audio from the output
line of the board being used. E.g.:
●● FD300 Output 1 B1 for audio output #1 of the FD300
board #1(the board and line numbers is to be selected
during configuration; for more information see point 5
of the Launching and configuring FDOnAir section);
●● FD322 Board 1 Output Stereo 2 Capture for the 2L and 2R
audio output lines (the 2nd stereo channel) of the
FD322 board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters above.

6

7

8

6. Click Apply (8) to validate the settings.
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4. Setting content distribution parameters
1. Open the Output tab (1) on the Session Properties panel.
2. Select how you want to distribute the content you want to
encode by activating one of the check boxes:
●● Push to server (2) – if you want the content distribution
to be initialized by WME. In this case, enter the
following:
●● Server name – Windows Media server address;
●● Publishing point – publishing point name;
●● Copy settings from – name of the publishing point
from which you want to copy the settings for new
publishing point;
●● Pull from encoder (3) – if you want the content
distribution to be initialized by server (or servers).
In this case, specify the port number for content
distribution in the Port number text box. To find
automatically the free port number click Find Free Port.
1

2

3

4

3. Click Apply (4) to validate the settings.

gg

Tip: Report the connection parameters (the port number and the IP-

address of the broadcasting server if you chose to distribute the
stream directly from WME, or Windows Media server address if
you chose to distribute the stream to the server) to the clients.
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5. Setting encoding parameters
1. You can set the stream encoding parameters on the Compression tab (1) on the Session Properties panel.
2. Specify the settings configuration in the Destination dropdown list (2).

1

2

6

3
4
5

7

3. Information on current parameters values is displayed in
the following lists:
●● Video (3) – image compression parameters;
●● Audio (4) – sound compression parameters;
●● Bit rates (5) (Kbps).
4. If it is necessary to edit the selected configuration or create
a new one, open the properties editing window by clicking
Edit… (6) or select necessary value on the Video, Audio and Bit
rates lists.
5. Click Apply (7) to validate the settings.
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Archiving broadcast using WME
To archive the content being broadcasted you can use the builtin WME function that allows storing the content to a Windows
Media file. Content may be stored during broadcasting to
network or independently.
For customizing the storing of the content being broadcasted
follow the same workflow as for broadcast setting and control
(see the Workflow in WME section).
On the Output tab (1) on the Session Properties panel follow the
additional steps below:

1

2
5

4

3

6
7
8

1. Select the Encode to file check box (2).
If you chose to store content during broadcasting (i.e. one of
the Push to server or Pull from encoder check boxes located on
the same tab is selected) the check box is called Archive to file.
2. Enter to the File name text box (3) the full path to the
file where you want to store broadcasted content. Click
Browse… (4) to open the default browse dialog box.
3. If you need to limit the size of the file being stored, select
the Limit by size check box (5) and enter the maximum
allowable file size to the text box on the right.
4. If you need to limit the duration of the file being stored,
select the Limit by duration check box (6) and specify the
maximum allowable duration in the HH:MM:SS format.
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5. Enter to the text box (7) the limit of the minimum allowable
free space on the hard drive. When free space on the hard
drive reaches this minimum a message that there is not
enough space appears.
6. Click Apply (8) to validate the settings.
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Example of broadcast to network using WME
Let us consider an example of WME use for broadcasting to
network based on the ForwardT Software set (the FD300
board). For examination of content being broadcasted to
network we will use Windows Media Player.

gg

Tip: For more information on WME, see its user's guide.
Let we have the FDOnAir application customized to broadcast
according to a schedule. For broadcasting we use the FD300
board #1 (1). For sound output we have selected the Sound1
board audio output (2).

1

2

27

To customize and launch broadcast to network follow these
steps:
1. Make sure that DirectShow filters are enabled for the
FD300 board #1. To do this, launch the FDConfiguration
application (the FDOnAir application must be closed) and do
the following:
●● In the Boards' Indexes list select the FD300 #1 board;
●● Click Advanced…;
●● Make sure that the A/V Capture filter check box (1) is
selected on the Board #1 Advanced Settings window.

1

2. Launch WME (2) by clicking Start: Programs > Windows Media >
Windows Media Encoder.
3. Click Properties (3) on the toolbar to open the Session Properties panel.
Steps 4-7 are to be followed on the Session Properties panel.
2
3
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4. On the Sources tab (4) do the following:
●● Select the Devices radio button (5);
●● Select the Video check box (6), select the SLDTM DShow
Output Capture board1 video device on the drop-down list
on the right (7);
●● Select the Audio check box (8), select the FD300 Output
1B1 audio device on the drop-down list on the right (9).
4

5

6

7

8

9

5. On the Output tab (10) do the following:
●● Select the Pull from encoder check box (11);
●● Click Find Free Port (12) to find a free port number
automatically. Found number is displayed in the Port
number field (13).
10

11
13

12
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6. Specify the broadcast settings configuration in the Destination
drop-down list (15) on the Compression tab (14).
14

15

7. Click Apply (16) to validate the adjusted settings. Click the
close button (17) to exit the settings window.

17

16
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8. Click Start Encoding (18) on the toolbar to start stream
broadcast to network.
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9. Click Start (19) to start the schedule playback.

19

31

10. Launch Windows Media Player.
11. Open the dialog box to connect with the stream by clicking
File > Open URL... (20).

20

12. In the Open URL window (21) enter the broadcasting server
URL and click OK.
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The address line looks like this:
where:

http://IP-address:port number

denotes the broadcasting server IP-address;
●● : is an obligatory separator;
●● port number denotes the broadcasting server port
number (see Step 5).
●● IP-address

32

13. In the Windows Media Player window content will be
displayed according to the schedule being played back in the
FDOnAir.

gg

Tip: To see the computer IP-address open a command prompt

window by clicking Start: Programs > Accessories > Command
Prompt. In the command prompt window type ipconfing and press
Enter. The network configuration details will appear in the
window, including IP address (1).

1

33

Workflow in FME
This section provides information about how you can use the
FME (Adobe Flash Media Encoder) when broadcasting to
network using the ForwardT Software set.

gg

Tip: For more information on FME, see the help files of the encoder.

1. General workflow for broadcast setting and control
1. Launch FME using its shortcut on the desktop or by clicking
Start: Programs > Adobe > Adobe Flash Media Encoder.
2. Customize the session on the Encoding Options panel (1):
steps 4–7.
3. Use

to minimize/maximize the panel (2).

/

5

2

1

4

3
6

7
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4. Specify sources of your audio and video content:
●● See Specifying and configuring sources of your audio
and video content for retranslation;
●● See Specifying and configuring sources of your audio
and video content for translation according to the
schedule.
5. Set the parameters of stream distribution (see the relevant
section below).
6. Set the content encoding parameters (see the relevant
section below).
7. Audio and video bit rate according to the current settings
are displayed in the Total Video+Audio Bit Rate field (3).
8. Select the following check boxes in the Preview group (4) to
display the relevant information in the preview window:
●● Input Video;
●● Output Video;
●● Audio – input audio stream.
9. Select the preview window size in the Preview Size drop-down
list (5).
10. To start the broadcast click Start (6).
11. To stop the broadcast click Stop (7).

2. Specifying and configuring sources of your audio and video content for
retranslation
1. You can specify and configure sources of your audio and
video content on the Encoding Option tab (1) on the settings
panel.
2. Select the Video check box. In the Device drop-down list (1)
specify the relative DirectShow filter capturing video from
the input line of the board being used as the source of your
video content.
1

E.g.:
●● SLTM DShow Video Capture board1

FD300 board #1;

for Line A of the
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●● SLTM DShow Video Line B Capture board1

the FD300 board #1;

for Line B of

for the Input 2 video
line of the FD322 board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters above.
●● FD322 Board 1 Input 2 Video Capture

3. Select the Audio check box. In the Device drop-down list (2)
of the Audio group specify the relative DirectShow filter
capturing audio from the input line of the board being used
as the source of your audio content.
2

E.g.:

●● FD300 Input 1 B1

board #1;

for audio input #1 of the FD300

for the 1L and 1R
audio input lines (the 1st stereo channel) of the FD322
board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters.
●● FD322 Board 1 Input Stereo 1 Capture

3. Specifying and configuring sources of your audio and video content for
translation according to the schedule
1. You can select and configure sources of your audio and video
content on the Encoding Option tab (1) on the settings panel.
2. In the Device drop-down list (1) of the Video group specify
the relative DirectShow filter capturing video from the
output line of the board being used (chosen for broadcasting
in FDOnAir, see point 4 of the Launch and configuring
FDOnAir section) as the source of your video content.
1

36

E.g.:
●● SLTM DShow Video Output Capture board1

the FD300 board #1;

for output of

for the output of the
FD322 board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters above.
●● FD322 Board 1 Output Video Capture

3. In the Device drop-down list (2) of the Audio group specify the
relative DirectShow filter capturing audio from the output
line of the board being used as the source of your audio
content. E.g.:
●● FD300 Output 1 B1 for audio output #1 of the FD300
board #1(the board and line numbers are to be
selected during configuration; for more information
see point 5 of the Launch and configuring FDOnAir
section);
●● FD322 Board 1 Input Stereo 2 Capture for the 2L and 2R
audio output lines (the 2nd stereo channel) of the
FD322 board #1.
For more information on naming and list of filters see in the
sections dedicated to DirectShow filters above.
2
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4. Setting content distribution parameters
1. Select the Stream to Flash Media Server check box (1) in the
Panel Options group.
2. Specify the connection to the Flash Media Server
parameters in the following text boxes:
●● FMS URL (2): Flash Media Server URL address;
●● Backup URL (3): backup Flash Media Server URL
address;
●● Stream (4): stream name.
3. Click Connect (5) to connect to Flash Media Server.

1
2

3

4
5
6
8
7

4. If needed, select the Save to File check box (6) and specify the
full path to the file in the text box (7) to store your content
to a file during its distribution.
Click Browse… (8) to open the default browse dialog box.
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5. Setting encoding parameters
1. You can set the stream encoding parameters on the Encoding
options tab.
2. Select the required configuration in the Preset drop-down
list (1).
The configuration defines the following parameters: audio
and video codec, bit rate, image size and frame frequency,
sound reproduction mode (mono/stereo) and sample rate.
1

If you need to customize a nonstandard configuration, select
Custom in the list and specify the required parameters.
In the Video group specify the following:
●● Format (2) – video codec name;
●● Bit Rate (3);
●● Size (4) – image size and frame frequency.
In the Audio group specify the following:
●● Format (5) – audio codec name and sound reproduction
mode;
●● Bit Rate (6);
●● Sample Rate (7).

3

5

2
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7

6
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3. Select frame size and required frame frequency using the
Size group drop-down lists (8). Frame size can be 720x576
only.

8

4. Select the Resize check box (9), if you need to change the size
of the image being broadcasted. Specify the size using the
Width and Height boxes.
Select the Maintain Aspect Ratio check box (10) if you need to
keep the image proportions during scaling.

9

10

5. Specify the volume level by moving the Volume slider.

11
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Useful Links
Forward T Product Line: Description, Software Delivery, Documentation, Ready
Solutions
http://www.softlab-nsk.com/forward/index.html

Support
http://www.softlab-nsk.com/forward/support.html
e-mail: forward@sl.iae.nsk.su
forward@softlab-nsk.com

Forum
http://www.softlab-nsk.com/forum (currently available in Russian only)
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